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What is gretl?

What is gret1?

e gretl isan acronym for Gnu Regression Econometrics and

* Time-series Library

* it is free econometrics software

* it has an easy Graphical User Interface (gui)

* it runs least-squares, maximum-likelihood, systems estimators... it
outputs results to several formats

* veryimportant for us in this course: it admits scripts (sequence of
commands saved ina file)
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What is gretl?

Howdo | get gretl?

Handy for remote learning since it is open-surce free software anyone
can install it on home desktop without the need of license

In order to install it go to:
http://gretl.sourceforge.net

It runs on Windows, Mac, Linux
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http://gretl.sourceforge.net/

Installation

* Open the webpage and go down where Download section is located.

x B

ot secure

Click on the circled button for windows users

gretl.sourceforge.net

. Supbort for machine learning via LIBSVM (details)

Besides gretl's core functionality, several addons and numerous contributed function packages are avail:
below.

Data formats

Supported formats include: own XML data files; Comma Separated Values; Excel, Ghumeric and Open C
files; SPSS .sav files; Eviews workfiles; JMulTi data files; own format binary databases (allowing mixed
lengths), RATS 4 databases and PC-Give databases. Includes a sample US macro database. See also the

Download

The current source package gretl-2020d.tar.xz

Debian GNU/Linux packages, maintained by Dirk Eddelbuettel packages.debian.org; see also packages
Fedora packages, maintained by Johannes Lips apps.fedoraproject.org

Whether you're compiling from source or installing a pre-compiled binary, you may want/need to check

Gretl for MS Windows can b¢ found here, and Yretl for Mac OS X here.

The time-series analysis programs X-13-ARIMA and TRAMO/SEATS are available in a form suitable for u



Installation

* Choose the .exe file which is appropriate for your system
B gretl for Windows x [+
&« O @ Notsecure | gretlsourceforge.net/win32/ B o= % @

[gretl main page]

Gretl: Gnu Regression, Econometrics and Time-series Library
for Microsoft Windows
System requirements

As of varsian 1.9.4, greti requires Windows XP or higher and a processor that supports the SSE2 instruction set. SSE2 support s found in all modern processors; It is absent in AMD CPUs prior
Athlon 64, and in Intel CPUs prior to the Pentium 4. For versions of gretl that will run on older systems,

Downloads

If you have the rights of a "power-user’ or better on Windows, choose a self-installer from the first or second column below; just download and run the exe file. This applies ta most people.
1f you have no administrator rights on Windows choose a zip archive from the third column; unzip this in any location where you have write permission. Nate: you must preserve the internal d

structure of the archive or greti will not work. In unzipping programs this option may be called "enable folders”. The whole archive is in a directory called gretl. For example, If you unzip the 2
Into a directory named c:\userdata, the gretl GUI program will be at c:\userdata\gretligret].exe.

The current "snapshot” of gratl is mors up to date than the release: often it will contain bug-fixes but sometimes it will contain newly introduced bugs. To ses what's new In the snapshot, take
at the Change log (the "in progress” entry).

Note: the 32-bit versian of gretl will run on 64-bit Windows, but not vice versa, If you're not sure if your Windows installation is 64-bit or not you can check at the Microsoft knowledge base
self-installer (32-bit) s g4-bit) OR

zip archive (no admin rights)

latest release (Aug 6, 2020) gre greti-2020d-win32.zip

OR current snapshot gretl_install-32.exe gretl-win32.2ip

The executables were cross-compiled under GNU/Linux using mingyi-w54. The free installer program s courtesy of Jordan Russell
Optional extras you may wish to install

X-13-ARIMA-SEATS (seasonal adiustm

t. ARIMA models) ¥13as install.exe OR (64-bit) x13as Install-64.exe



Installation

* Run the .exe file and choose default options to proceed. Do not
forget to add gretl directory to your PATH

ﬁ% Setup - gretl version 2020d (x86_64) — X
Select Additional Tasks ‘
Which additional tasks should be performed? @

Select the additional tasks you would like Setup to perform while installing gretl, then
click Next.

Add gretl directory to your PATH



Start gretl

* To start gretl you can just type gret1 in your search button.
Select it and an empty gretl window will pop out. You can
either run commands directly in the gretl console or write

scripts and save them for future use

B ot

Eile Tools Data ev \dd

No datafile loaded

ID# 4 Variable name 4 Descriptive label
Gretl Gretl
scripts console

M

Help

=
C:i\Users\dalihDocuments\gret!
4




What is gretl?

How do | work with gret1?(1/2)

+ the easiest way for beginners is by using its graphical user interface

* you can also use the console button of the toolbar: from the prompt
(?) you can execute gret1 commands one line at a time.

+ the most efficient way is by usingscripts:
I create a script file, write gretl commands one every line, and save it
& run the script using the gui

E¥ inspect output
@ ifneeded, change script file, save it, and go back to step 2
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Running commands in the script

* Click CTRL + R or click the button shown below. The window with
outputs (or errors) will open. If you save these scripts, it will be
saved as .inp file.

| gretl: untitled — O

mmamg DOAPeeXEoEE
ols wage educatdesa




What is gretl?

How do | work with gret1?(2/2)

you know your way using the gui, but want to know about scripts...

I actions you do with the gui are stored as scriptina filed called
session. inp

B gretl comes with over 70 practice scripts

B the manual gives good advice and devotes several chapters to provide
good programming solutions

& this course will provide you with tested scripts
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Opening datasets

U Gretl comes with inbuilt datasets which you can play with

U Go File -> Open data -> Sample file and this will give you lots of
datasets, or alternatively, go to specific data file which you
want to access in your computer by choosing User file instead
of sample file

“ gretl
Eile' Tools Data View Add Sample Variable Model Help
Open data r User file... Ctrl+0 | ¢
Append data.. = samplefile.. e
& Sevedata Ctrl+S
E Save data as.. T
) . . 2. data3-1.gdt
xport dat
- port data 3. collegetown.gdt
Send To.. 4, data3-4.gdt
| ] New data set Ctrl+N 5. wgmacro.gdt
@ Clear data set 6. bachelor.gdt

Working directory...

Script files
Session files

Databases

vy v v v v

Function packages
Resource from addon

o] Quit Ctrl+Q



U If you want to open file which has a different extension, for example

Opening datasets

excel, when you go to User File, do not forget to set it for excel
searching, otherwise nothing will be shown in the window

gretl: open file

) Recently Used

Places
|, Search

€ Recently Used
[ gret!

[ datil

[ Desktop

& Windows (C:)

Name

€ beer.gdt

4 Size Modified v
2.5kB VYesterday at 14:10

Gretl datafiles (*.gdt, *.gdtb)
CSV files (*.csv)

ASCII files (*.txt)

Gnumeric files (*.gnumeric)
Open Document files (*.ods)
Excel files (*.xls)

Excel files (*.xlsx)

Stata files (*.dta)

Eviews files (*.wf1)

SPSS files (*.sav)

SAS xport files (*.xpt)

IMuITi files (*.dat)

Shapefiles (*.shp)

GeoJSON files (*.geojson, *.json)
all files (%)

Gretl datafiles (*.gdt, *.gdtb)




Opening datasets

U For now let’s open a Sample file the very first one offered ‘abdata’
by double-clicking it with a mouse

H gretl: data files — O
208

I Gretl Greene Ramanathan
File 4 Summary 4 Type
abdata Arellano and Bond (1991) panel data panel, T=9 N=140

1 anscombe Anscombe's Quartet (artificial data) cross section, n=11
arma Artificial data for ARMA script example time series, T=624
australia Johansen's Australian macroeconomic data time series, T=77
AWM Euro area macroeconomic data, 1970-1998 time series, T=116
AWMIT Euro area macroeconomic data, 1970-2016 time series, T=188
AWMI18 Euro area macroeconomic data, 1970-2017 time series, =192
banks91 Costs of ltalian commercial banks cross section, n=198
b-g Bollerslev and Ghysels exchange rate data time series, T=1974
bjg Box and Jenkins Series G (airline passengers) time series, T=144
brand_cassola Euro area money demand data time series, T=79
broiler Epple and McCallum broiler chicken data time series, T=52
CEL Caselli, Esquivel and Lefort growth panel data panel, T=8 N=97
chomage D.5.G. Pollock's Swiss unemployment data time series, T=66
rradernre freena'c rradit conrinm data rroce cartinn n=100




Playing with data

* The following window will pop out. You can now check the values of
each variable by double clicking them. You can edit them etc.

H gretl - O X
File Tools Data View Add Sample Variable Model Help L—j
abdata.gdt C:\Users\dali\Documents\gret|
ID# 4 Variable name 4 Descriptive label 4

0 const

2 YEAR year of observation (1976 to 1984)

3 EMP U.K. employment in company i at end year t

4 WAGE real product wage

5 CAP gross capital

6 INDOUTPT industry output

7 n log of employment

8 w log of real product wage

9 k log of gross capital

10 ys log of industry cutput

11 unit individual (firm) index



Operations on variables

U See summary statistics of variables by highlighting them and
clicking Variable -> summary statistics in the upper panel

O Change values of variables by highlighting it and clicking Data ->
Edit values

&

File Tools View Add Sample Variable Model Help
Examplelxl  select all Ctri+A
D# |vai|
Display values

0] con: -

1 YEA! Edit values h

2 unitf Add observations...

3 EMF R t

Dataset info
Observation markers...

Dataset structure...

Transpose data...

Sort data...

Set missing value code...
Count missing values

Find variable... Ctri+F
Refresh window

Undated: Full range 1 - 900
WO b s




Savingasanewgretl1 File

You can open any other type of file using gretl (excel), do some operations on them
and then save as a gretl file (.gdt) by cllcklng File -> Save Data as -> Standard
format

Jil5} Tools Data View Add Sample Variable Model Help

Open data »>

Append data » |ve label

Save data ctri+s |erated constant

Save data as » Standard format... %
Export data > Database...

Send To...

Clear data set

Working directory...

Script files >
Session files >
Databases =
Function files »
Exit Ctri+X

Undated: Full range 1 - 900
A 2 -« 7 S S
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Looking at the Session Script

Tools> Command log displays the operations that we have done so far. It is
recorded only if we run the commands from the console or GUI. If we run them
from the script, logs won’t record them

E gretl

File

BB Data Vview Add Sample Variable Model Help
Exam|  statistical tables

[ID#|  Pp-value finder el
0|  pistribution graphs d constant
; Plot a curve
3 Test statistic calculator

Nonparametric tests
Seed for random numbers

Command log [}
Gretl console

Start GNU R

NIST test suite >
Preferences >

Undated: Full range 1 - 900

N 20/42
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Running a Script

More on scripts

w using File/Script files/New script you open the command script editor

w Ifyou have a very long command that exceeds one line, use the
backslash (\) as a continuation command

m using scripts (and the console) requires you to use the correct
language syntax

m gretl's language is case sensitive: gret1 considers xto be different
from X

m you can find all the commands inthe gret1 command reference after
clicking Help -> command reference

w at the console window, you can type help



Exercise 1

» Load the file engel.gdt. The data set contains two variables named
income and foodexp. The variable foodexp is annual expenditures on food
in a household and income is annual income measured in $100
increments.

» Using GUI, add natural logs of both variables.
» Using GUI, summarize foodexp for households with income below the

median.
+ Using GUI, plot foodexp againstincome.
* Write all the commands in a script file and save it.
* Open the script and run the commands.
+ Save the new dataset.
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Exercise 2

The file bweight.xIsx contains information about infants' birth weight, sex
and race, the income of their faimilies, their parents' education and the
number of cigarettes the mother smoked per day during pregnancy (msmoke).

@ Import from gretl the file bweight.xlsx

B Compute the average birth weight for all the babies in the sample, and
separately for boys and girls.

B Compute the proportion of mothers that smoked during pregnancy.

@ Which familiy variables do you think are related to children’s birth
weight? Compute the correlation among bweight and those variables.

B Save the new database in gretl format.

@ Write down all the previous commands ina script and save it. Close
your session, open the script and run all the commands together.



First Exercises

Basic commands for data management (1/2)

Commands on the entire data
® open: opensa data file replacing any data file already open
# smpl: defines the sample range
¥ dataset: Ssorts/clears/transposes/adds observations and more

® setobs: declares the structure of the data (cross-section, time-series,
panel)

mw append: appends the content of a data to the current dataset
m store: Savesthe datainto a file
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First Exercises

Basic commands for data management (2/2)

Basic commands on variables
w genr: createsa new variable
delete: removes variables
setinfo: Sets attributes of a variable
rename: renamesa variable
summary: Shows summary statistics for variables

print: liststhe values of variables
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Commands on Datasets

open dataname ——www ——sheet= "name"
——coloffset=# ——rowoffset=#

= opens a dataset replacing any already loaded data
® ——WWwWWw opens database ingret1 server

w With spreadsheets, it selects the worksheet, and the first column and
row

w the first row must contain valid variable names. In the case of an
ASCII or CSV import, ifthe file contains no row with variable names
the program will automatically add names, v1, v2 and so on.

open C:\there\mydata.xls ——sheet= mysheet ——coloffset=3
——rowoffset=2

= opens worksheet mysheet from C:\there\mydata.xIs
® reads the data from the fourth column and third row




Commands on Datasets

smpl (#start #end | condition ——restrict | #
——random | full) ——replace ——balanced

w condition ——restrict: restricts the sample to observations that satisfy

the condition
w # ——random: # casesare ramdomly selected
w full: restores the full data range

previous restrictions

sample restrictions are by default cumulative: ——replace turnso ff all

s

Examples

smpl YEAR!=1976 ——restrict

smpl EMP > 3 —-—restrict ——replace
smpl 50 ——random
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Commands on Variables

Ffename varname newname

= changes the name of the variable
= hames must be of 15 characters maximum

w they must start with a letter

w they must be composed of only letters, digits, and the underscore
character

Example in bwght.gdt
w rename bweight birth_weight
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Commands on Datasets

dataset (addobs# | transpose | sortby varname
resample # | clear)

addobs: adds extra observations at the end
transpose: transposes current data set.

sortby: sorts data by varname (dsortby: descending order) (a list of
variables can be provided; available only for undated data).

resample: random sampling (Constructs a new dataset by random
sampling, with replacement, of the rows of the current dataset. The
original dataset can be retrieved via the command smpl full).

clear: clears out currentdata

Examples
dataset sortby msmoke

dataset resample 500
dataset clear




Commands on Datasets

setobs #freq #start (——cross-section | ——time-series |
——stacked-cross-section | ——stacked-time-series)

w #freq represents frequency in time-series data

w inpanel, #freq is units in stacked cross-sections or periods in stacked
time series

w for cross-sections, #freq=1
@ #start=1 for panels and cross-sections in
w time series, #start is the starting date
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Commands on Datasets

setobs unitvar timevar ——panel-vars

w imposes a panel interpretation
w Sorts data as stacked time series, by ascending values of unitvar

Examples
w setobs 1 1 ——cross-section
w Setobs 20 1:1 ——stacked-time-series
@ Setobs unit year ——panel-vars
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Commands on Datasets

append newdata ——time-series

w opens a data file and appends the content to the current dataset
w First case: additional observations for existing variables

w Second case: new variables (best if # obs compatible)

@ Third case: appends a time seriesin a panel

First Case
# open C:\there\Example2.xls ——sheet= first100
# append C:\there\Example2.xls ——sheet= moreunits
# appends worksheet moreunits fromC:\there\Example2.xls

Second Case
® append C:\there\Example2.xls ——sheet= wages
¥ appends worksheet wages from C:\there\Example2.xls




Commands on Datasets

append

Third Case
w You have a panel and you want to add a variable which is available in
time-series form. For example, you want to add annual CPI data to a
panel in order to de ate nominal income gures.

@ open the data: C:\there\Example2.xIs ——sheet= first100
@ You need to have a panel: setobs unit year panel-vars
@ append C:\there\Example2.xls ——sheet= cpi
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Commands on Variables

[genr] newvar = formula

w a formulais a well-formed function ofvariables

w the range over which the result is written depends on the current
sample

w arithmetical operators: ~, *,/, + , -

w boolean operators: ! (negation), && (AND), || (OR), >, <, =, >=
<= ,|lI=

w look at the gret1 Function Reference (Help/Function Reference) for
built-in functions

Examples
woenry= 3+ 2*x1+ 5*x2+ error
g D1976 = (YEAR = 1976)

w genravgy = mean(y)




Commands on Variables

delete [varlist ] ——db

w removes listed variables

w Ifno varlist is given, it deletes the last (highest numbered) variable
from the dataset

w ——db: deletes variables from a gretl database
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Commands on Variables

setinfo varname —d "thislabel” —n "thisname" ——discrete
——continuous

w —d "thislabel”: thislabel isset as the variable's descriptive label

w —N "thisname": thisname iS used in place of the variable's name in
graphs

w ——discrete: marks variable as discrete (by default variables are
continuous)

Examples
w Setinfo x1 —d "Description of x1" —n "Graph name"

w setinfo z ——discrete
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Commands on Variables

print [varlist] ——byobs ——no-dates

m prints the values of the variablesin varlist

w if no list is given, prints the values of all variables
w ——byobs: data are printed by observation, not by variable

@ You can also printstrings

Examples
w print bweight male ——byobs

@ print bweight ; male ——byobs
@ print "This isa comment"
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